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© Copyright VIDAR Systems Corporation. Tutti i diritti riservati. 
 
Nessuna parte della presente pubblicazione può essere riprodotta, conservata in alcun tipo di 
sistema o trasmessa in qualsiasi forma e con qualsiasi mezzo (elettronico, meccanico, fotocopia, 
registrazione o altro) per qualsiasi scopo, senza previa autorizzazione scritta di VIDAR Systems 
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ClinicalExpress è un marchio registrato di VIDAR Systems Corporation. 
 

VIDAR® fornirà assistenza sulla base dei termini e delle condizioni indicati nel contratto 
di licenza. Altri termini e condizioni potrebbero essere stati presentati dai rivenditori 
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 L'apparecchiatura viene utilizzata conformemente alle istruzioni contenute nel 
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Uso previsto 
 

 
ClinicalExpress è progettato per l'inoltro di immagini DICOM da un 
digitalizzatore di immagini mediche a un provider di archiviazione o un provider 
di stampa DICOM. Questo prodotto è destinato a utenti che intendono servirsi di 
un digitalizzatore di pellicole mediche per eseguire la scansione di pellicole 
analogiche o trasmissive su una workstation DICOM tramite la tradizionale 
teleradiologia, nonché a utenti che desiderano eseguire duplicati di stampe di 
pellicole mediante la tecnologia digitale in protocolli DICOM e PostScript. 
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Informazioni su questo manuale 

 

Questo manuale fornisce istruzioni dettagliate per l'installazione e l'uso di 
ClinicalExpress®. Il manuale tratta i seguenti argomenti: 

 Informazioni su ClinicalExpress descrive ClinicalExpress come parte di un 
tipico sistema di radiografia o mammografia DICOM. 

 Installazione di ClinicalExpress descrive i requisiti di sistema e fornisce 
istruzioni sull'installazione del software. 

Nota: per informazioni sulla connettività, consultare la 
Dichiarazione di conformità DICOM, un documento a parte. 

 Configurazione di ClinicalExpress mostra come configurare i sistemi di 
acquisizione e trasmissione di pellicole radiografiche ClinicalExpress e tratta 
altri argomenti di interesse per chi gestisce sistemi ClinicalExpress. 

Nota: le istruzioni di funzionamento sono riportate in un altro 
manuale intitolato "ClinicalExpress - Guida dell'operatore”. 

Convenzioni utilizzate in questo manuale 
 I tasti speciali che l'utente deve premere sulla tastiera vengono riportati 

utilizzando LETTERE MINUSCOLE. Ad esempio, quando si legge la parola INVIO 
nel testo, premere il tasto corrispondente sulla tastiera. 

 I nomi dei menu e i comandi dei menu vengono riportati in stampatello. Ad 
esempio, il menu File contiene il comando Installa licenza (Install License). 
Nel presente manuale, i comandi sono espressi con una notazione abbreviata. 
Ad esempio, File > Esci (File > Exit) significa selezionare il comando Esci 
(Exit) nel menu File. 

 Finestre, pulsanti, finestre di dialogo e altre funzioni visualizzate sullo 
schermo sono riportati in grassetto. Ad esempio, la finestra Login 
ClinicalExpress (ClinicalExpress Login, riportata di seguito) contiene i 
campi Nome utente (User Name) e Password, nonché i pulsanti OK e 
Annulla (Cancel). 
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Informazioni su ClinicalExpress®
 

 

 
 
 
ClinicalExpress 6.0 è un programma su base Windows che digitalizza pellicole e 
trasmette immagini su pellicola. Il programma incorpora le modalità Radiografia 
generale e Mammografia e può essere acquistato per la sola modalità Radiografia 
generale, per la sola modalità Mammografia o per entrambe. 
 
Digitalizzazione. Utilizzando un digitalizzatore di pellicole VIDAR per l'input, 
ClinicalExpress visualizza immagini su pellicola e le associa a un paziente e a 
uno studio. Il programma fornisce una serie di controlli per esaminare 
un'immagine per il controllo qualità e la regolazione delle sue caratteristiche. 
 
Indicazioni per l'uso. Le immagini di radiologia generale digitalizzate 
utilizzando ClinicalExpress soddisfano o superano gli standard ACR e DICOM 
per l'uso di immagini di acquisizione secondaria a fini di consulto, analisi e 
interpretazione finale. 

 
Le immagini di mammografie digitalizzate utilizzando ClinicalExpress come 
DICOM MG devono essere adoperate solo come riferimento o per confronto, e 
non per la diagnosi primaria. 
 
 
 
Opzioni 
 
Queste opzioni possono essere acquistate separatamente: 
 
Modality Worklist. Questa opzione consente alle modalità di imaging di 
scaricare informazioni delle liste di lavoro relative a procedure pianificate e ai 
dati correlati, presentare queste informazioni all'operatore della modalità e 
assicurare che le immagini DICOM contengano dati descrittivi congruenti. Le 
istruzioni per l'utilizzo della funzione Modality Worklist in ClinicalExpress sono 
fornite nel presente manuale. I dettagli sull'integrazione sono forniti nella 
Dichiarazione di conformità DICOM. 
 
PDI. Questa opzione include le funzioni Importazione/esportazione mediante 
supporto DICOM (per la lettura e la scrittura di CD DICOM), Scansione carta 
FlatBed e Query paziente (per cercare informazioni relative ai pazienti su 
dispositivi di archiviazione). 
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Panoramica del sistema 
Una tipica workstation di acquisizione pellicole e trasmissione ClinicalExpress è 
composta da: 

 Digitalizzatore di pellicole VIDAR per creare immagini digitali da pellicole 
radiografiche. 

 Computer con Windows® XP 32 bit o Windows 7 32 o 64 bit sul quale è 
installato il programma ClinicalExpress. 

Note 

 La workstation ClinicalExpress NON è una workstation 
diagnostica. Per attività diagnostiche, utilizzare una 
workstation appropriata (per istruzioni, consultare la guida 
all'installazione e all'uso della workstation diagnostica). 

 Le immagini di mammografie digitalizzate con 
ClinicalExpress devono essere utilizzate unicamente a fini di 
riferimento ed analisi, e non possono essere utilizzate per la 
diagnosi primaria. 

Modalità Radiografia generale 

Per la trasmissione delle immagini, la workstation utilizza una connessione dati, 
la quale fornisce dati sulle immagini a un sistema o ad una workstation remota. 
Per la copia, la workstation si connette a una stampante di pellicole o a un 
dispositivo di output di altro genere. Ulteriore input può essere fornito da uno 
scanner di documenti opzionale. 
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Modalità Mammografia 
 
Per la trasmissione delle immagini, la workstation utilizza una connessione dati, 
la quale fornisce dati sulle immagini a un sistema o ad una workstation remota. 
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Utilizzi di ClinicalExpress 
 
ClinicalExpress 6.0 è un efficiente punto di controllo per l'acquisizione,  
la trasmissione e la copia di pellicole. Questo programma consente di: 

 Digitalizzare 
 Richiamare un paziente e uno studio esistenti oppure creare un nuovo 

record paziente e/o uno studio. 
 Utilizzare l'opzione Modality Worklist (disponibile separatamente) per 

raccogliere informazioni sui pazienti da un'origine esterna (anziché digitare 
i dati del paziente). 

 Impostare parametri di digitalizzazione di base: profondità in bit e 
risoluzione. 

 Digitalizzare una o più pellicole. 
 Eseguire un controllo qualità sull'immagine creata dalla pellicola prima di 

inviarla o copiarla. 
 Manipolare l'immagine: impostare finestra e livello, ruotare, capovolgere, 

invertire i valori tonali, dividere immagini, ingrandire un'area di interesse, 
zoomare e oscurare dati sensibili. 

 Trasmettere 
 Selezionare un sistema o una workstation remota (la "destinazione"). 
 Inviare immagini digitalizzate alla destinazione selezionata. 
 Digitalizzare e inviare in un'unica operazione. 

 Copiare (solo per la Modalità Radiografia generale) 
 Selezionare una stampante (nel caso in cui al sistema siano collegate più 

stampanti). 
 Impostare il numero di copie da eseguire da ciascun originale di pellicola. 
 Avviare la stampa. 
 Combinare più immagini su una pellicola. 
 Digitalizzare e stampare in un'unica operazione. 

 Importare da ed esportare su CD standard DICOM. 

ClinicalExpress viene concessa in licenza in base alle funzioni/funzionalità 
fornite. Tutte le licenze includono la funzione di digitalizzazione nonché quella di 
Invio DICOM (invio a provider di servizi DICOM, workstation/PACS) e Copia 
DICOM (stampa su stampanti DICOM e/o dispositivi Postscript). Inoltre, è 
possibile acquistare licenze per: 

 Modality Worklist. 

 PDI. Masterizzazione di CD dal programma di visualizzazione DICOM a 
Esportazione su supporto, Importazione/Esportazione mediante supporto, 
Query paziente e Scanner documenti cartacei. 

Nuove funzioni in ClinicalExpress 6.1 
 Nuove opzioni per il formato data. 
 Supporto per tag Derivata/Primaria per mammografie DICOM per la 

compatibilità con siti GE. 
 Supporto per l'acquisizione di tag di data per mammografie per la 

compatibilità con siti Siemens. 
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Installazione di ClinicalExpress®
 

 

 
 
 

Requisiti del sistema 
 
Per digitalizzare e trasmettere immagini utilizzando ClinicalExpress®, è 
necessario disporre di un computer, di un digitalizzatore di pellicole VIDAR e di 
una connessione alla rete. 

Computer 
 
I requisiti minimi del computer per Windows XP a 32 bit SP3 sono: 
 PC Pentium 4 da 3.0 GHz 
 2 GB di memoria; è richiesta più memoria per serie numerose di immagini ad 

alta risoluzione come nella mammografia 
 50 GB di spazio libero sul disco rigido 
 
I requisiti minimi del computer per Windows 7 Professional a 32 bit e a 64 bit 
sono: 
 PC Dual Core 2 da 1,8 GHz 
 4 GB di memoria, è richiesta più memoria per serie numerose di immagini ad 

alta risoluzione come nella mammografia 
 50 GB di spazio libero sul disco rigido 
 
Caratteristiche video per tutti i computer: 
 Scheda video con 16 MB di memoria, impostata su una risoluzione di 

1280x1024 pixel e una profondità colore di 64.000 colori o superiore 
 Schermo da 20 pollici con risoluzione di 1280x1024 dpi 
 
 
Digitalizzatore di pellicole 
 
ClinicalExpress funziona con la maggior parte dei Digitalizzatori di pellicole 
radiografiche VIDAR. Contattare Medtech all'indirizzo medtech@vidar.com per 
stabilire se il proprio digitalizzatore è compatibile. 
 
ClinicalExpress non funziona con digitalizzatori di pellicole di altri produttori. 

Connessione di rete 
 
Alcune delle connessioni di rete idonee sono LAN, WAN, wireless e una varietà 
di servizi di gestori telefonici. È necessario il protocollo TCP/IP per consentire il 
corretto funzionamento. I dettagli relativi alla connessione di rete non rientrano 
nell'ambito di competenza di questo manuale. 
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Scanner documenti opzionale 
 
È possibile aggiungere al sistema uno scanner documenti USB. ClinicalExpress 
funziona con gran parte dei driver TWAIN. La possibilità di utilizzare uno 
scanner documenti è offerta come opzione a pagamento. Contattare l'assistenza 
tecnica VIDAR (vedere sotto) per ricevere un elenco degli scanner testati. 
 
 

Scenari di installazione 
 
Esaminare gli scenari seguenti per stabilire il proprio stato attuale e in che modo 
eseguire l'installazione di ClinicalExpress 6.0. 
 
 
 Se si sta installando ClinicalExpress per la prima volta: 

1. Eseguire il file ClinicalExpress6.x..exe presente nel CD di ClinicalExpress. 

2. Il software funzionerà in modalità valutazione per 30 giorni. Per utilizzare 
il software oltre i 30 giorni, è necessaria un codice di licenza (vedere 
"Ottenere un codice di licenza ClinicalExpress” più avanti nel presente 
capitolo). 

 
 
 Se è già installata una versione precedente di ClinicalExpress: 

 In caso di versione 4.x o precedente, contattare l'assistenza tecnica VIDAR 
(vedere sotto) per ricevere istruzioni su come effettuare l'upgrade. 

 In caso di versione 5.0 o successiva, è possibile installare ClinicalExpress 
6.0 senza disinstallare la versione precedente. 

 
 
 

Contattare l'assistenza tecnica VIDAR per eventuali 
domande sull'installazione del software ClinicalExpress: 

Telefono: +1.800.471.SCAN (+1.800.471.7226) 

 +1.703.471.7070 al di fuori degli Stati Uniti 

E-mail: medtech@vidar.com 
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Panoramica sull'installazione 

 
Nota: è necessario essere collegati come Amministratore per 
installare ClinicalExpress e svolgere le funzioni amministrative. 
Gli utenti possono avere, ma non richiedono diritti amministrativi 
per il PC. Per istruzioni consultare: 
 L'argomento “Per Aggiungere un membro a un gruppo” nella 

Guida e supporto tecnico di Windows XP. 
 L'argomento “Creare un nuovo account utente” e “Modificare 

un account utente” nel file di guida della finestra Gestione 
computer di Windows. 

 
L'installazione prevede cinque punti generali: 

A. Installare e configurare il digitalizzatore di pellicole. 

B. Configurare lo schermo. 

C. Installare il software ClinicalExpress. 

D. Avviare ClinicalExpress. 

E. Ottenere un codice di licenza ClinicalExpress. 

 
I dettagli vengono forniti nelle sezioni seguenti. 
 

Suggerimento: se si sta creando una nuova workstation, non 
installare tutti i componenti contemporaneamente. Installare 
prima il digitalizzatore di pellicole (seguendo le istruzioni fornite 
con il digitalizzatore).  Quindi, configurare lo schermo (punto B). 
Infine, installare il software ClinicalExpress (punto C) e 
accertarsi che il sistema sia operativo. 

 
 
 

A. Installare e configurare il digitalizzatore di pellicole 
 
Installare e configurare il digitalizzatore di pellicole e il relativo software 
seguendo le istruzioni fornite con il digitalizzatore (i dettagli su questo aspetto 
esulano dalle finalità del presente manuale). 
 
 

Nota: è possibile scaricare le guide all'installazione e all'utilizzo 
del digitalizzatore di pellicole VIDAR nella sezione Assistenza 
clienti del sito www.filmdigitizer.com. È inoltre possibile 
richiedere i manuali chiamando il numero +1.800.471.7226 
(+1.703.471.7070 al di fuori degli Stati Uniti.). 
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B. Configurare lo schermo 
 
1. Con il pulsante destro del mouse fare clic sul desktop, quindi fare clic su 

Proprietà (Properties) nel menu a comparsa. 
 

  
 

Nota: sul sistema in uso, il comando Proprietà (Properties) 
potrebbe essere sostituito da un comando specifico per 
l'adattatore video. In tal caso, fare clic su quel comando. La 
finestra di dialogo delle proprietà dello schermo può essere 
diversa ma la finalità è la stessa: impostare la risoluzione dello 
schermo a 1280x1024 o superiore e impostare la profondità di 
colore a 16 bit o superiore. 

 
2. Nella finestra Proprietà dello schermo (Display Properties) fare clic sulla 

scheda Impostazioni (Settings). 
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3. Impostare l'Area dello schermo (Screen Area) (o Risoluzione dello schermo 
(Screen Resolution)) su 1280x1024 o superiore e impostare i Colori (Colors) 
o Qualità del colore (Color Quantity) su Alta (16 bit) High color (16 bit) o 
superiore. 

 

  
 
4. Fare clic su OK. 
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C. Installare il software ClinicalExpress 
 

Nota: se si esegue l'aggiornamento da ClinicalExpress 4.x o 
alla versione precedente, contattare l'assistenza tecnica VIDAR 
all'indirizzo medtech@vidar.com per istruzioni. 

 
Nota: è possibile installare ClinicalExpress senza il 
digitalizzatore di pellicole nel sistema. Tuttavia, ClinicalExpress 
non funzionerà fino a quando il digitalizzatore di pellicole non 
verrà collegato al computer, non verrà accesso e non 
comunicherà con il computer. 

 

1. Inserire il CD di ClinicalExpress nell'unità CD del computer. 
 
2. In Windows Explorer, accedere all'unità CD, quindi fare doppio clic su 

ClinicalExpress6.x..exe. 
 
3. Seguire le istruzioni nella finestra del programma di installazione. 
 
 Durante l'installazione verrà richiesto di selezionare l'interfaccia utente 

predefinita — Radiografia generale o Mammografia — da visualizzare 
all'avvio di ClinicalExpress. Selezionare l'interfaccia utente più idonea  
(questa scelta può essere modificata nella pagina Amministrazione > Locale 
(Administration > Local) di ClinicalExpress). 

 
4. Al termine dell'installazione, rimuovere il CD dall'unità CD-ROM.  

(Sarà necessario il codice del CD, riportato sulla copertina del CD stesso,  
nel punto E). 

 
 
 
 

Come aggiungere uno scanner documenti a lastra 
 
È possibile installare uno scanner per documenti a lastra da utilizzare con 
ClinicalExpress. Seguire le istruzioni di installazione del produttore dello 
scanner. VIDAR ha testato dei tipici scanner USB 2.0 con driver TWAIN e ha 
riscontrato che sono compatibili con ClinicalExpress. 
 

Nota: nella workstation ClinicalExpress deve essere installato 
soltanto il driver TWAIN dello scanner a lastra. La presenza di 
qualsiasi altro driver TWAIN può interferire con il funzionamento 
di ClinicalExpress. Contattare l'assistenza tecnica VIDAR 
all'indirizzo medtech@vidar.com per ricevere un elenco degli 
scanner testati. 
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D. Avviare ClinicalExpress 
 

Nota: ClinicalExpress funziona per un periodo di 30 giorni 
senza un codice di licenza. Per continuare a utilizzare 
ClinicalExpress dopo questo lasso di tempo, contattare VIDAR 
Systems Corporation per richiedere un codice di licenza (le 
istruzioni sono riportate nella prossima sezione). 

 
1. Fare doppio clic sull'icona di ClinicalExpress presente sul desktop.  
  oppure 
 Start > Programmi > ClinicalExpress. 
 
2. Viene visualizzata la finestra Login utente (User Login): 
 

  
 
3. Utilizzare il nome/la password predefiniti dell'Amministratore: 

a. Lasciare Admin come Nome utente (User Name). 
b. Lasciare il campo Password vuoto. 
c. Fare clic su OK. 

 
4. Se il digitalizzatore è acceso e correttamente collegato, comparirà il 

messaggio seguente. Fare clic su OK. 
 

  
 
5. Viene avviato ClinicalExpress. 
 

Nota: non è possibile digitalizzare pellicole finché non viene 
definito almeno una destinazione valida. Consultare il prossimo 
capitolo del presente manuale: “Configurazione di 
ClinicalExpress”. 
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E. Ottenere un codice di licenza ClinicalExpress 
 

Nota: non è possibile ottenere un codice di licenza inviando via 
fax il contratto di licenza di ClinicalExpress. È necessario 
seguire le istruzioni riportate in questa sezione per ottenere un 
codice di licenza tramite e-mail. 

 
Per ottenere un codice di licenza, procedere come segue: 
 
1. Generare un codice di riferimento e inviarlo a VIDAR: 
 

Nota: è possibile generare un codice di riferimento soltanto se il 
computer su cui è installato Clinical-Express è collegato a un 
digitalizzatore di pellicole VIDAR. 

 
a. Nella finestra principale di ClinicalExpress, selezionare File > Genera 

codice di riferimento (File > Generate Reference Code). 
 
b. Nella casella di dialogo Genera codice di riferimento (Generate 

Reference Code): 
 Inserire o modificare il valore nei campi Nome utente (User Name), 

Azienda (Company) e Paese (Country). 
 Nel campo Codice CD (CD Key), inserire il codice CD riportato sulla 

copertina del CD di installazione di ClinicalExpress. 
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c. Fare clic sul pulsante Genera codice di riferimento (Generate Reference 
Code). 

 

  
 

Nota: il codice di riferimento è valido per 15 giorni. 

 
d. Fare clic sul pulsante Salva (Save) per salvare il codice di riferimento 

come file sul disco rigido locale. Salvare il file in una posizione facile  
da ricordare. 

 
e. Fare clic sul pulsante Chiudi (Close). 
 
f. Aprire un nuovo messaggio e-mail. 
 
g. Nel campo A del messaggio inserire medtech@vidar.com . 
 
h. Quindi: 
 
 Individuare il file (con estensione .ref) che è stato salvato nel punto  

d descritto sopra e allegarlo al messaggio. 
 
i. Inviare il messaggio. 
 

Nota: mentre si è in attesa del proprio codice di licenza, è 
possibile utilizzare ClinicalExpress in modalità di valutazione 
senza il codice, per un periodo massimo di 30 giorni. Durante il 
periodo di prova di 30 giorni, tutte le funzioni sono abilitate. 
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2. Dopo aver ricevuto via e-mail il proprio codice di licenza da VIDAR: 
 

a. Salvare l'allegato (con estensione .key) sul desktop. 
 
b. Eseguire il login a ClinicalExpess come Amministratore. 
 
c. Nella finestra principale di ClinicalExpress, selezionare File > Installa 

licenza (File > Install License). 
 

  
 
d. Nella finestra di dialogo Installa licenza (Install License): 
 
 Fare clic sul pulsante Carica da file (Load From File), quindi 

individuare e aprire il file del codice di licenza (con estensione .key). 
 

  
 
e. Fare clic sul pulsante Registra (Register). 
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f. Se il codice di licenza viene accettato, verrà mostrata la finestra seguente. 
Fare clic su OK. 

 

  
 
g. File > Esci (File > Exit). 
 
h. Avviare nuovamente ClinicalExpress facendo doppio clic sull'icona di 

ClinicalExpress sul desktop. 
 
i. Per verificare la propria licenza: Guida > Informazioni su (Help > 

About). La licenza è indicata in cima alla pagina. Se si possiede una 
licenza sia per Radiografia generale che per Mammografia, è necessario 
eseguire la verifica in entrambe le applicazioni. 

 
3. Andare al capitolo seguente del presente manuale, “Configurazione di 

ClinicalExpress”, per configurare il programma. 
  oppure 
 Se occorre configurare ClinicalExpress per la stampa, consultare le istruzioni 

di impostazione delle stampanti validate per l'utilizzo con ClinicalExpress, 
nella cartella Specifica stampante presente nel CD di installazione di 
ClinicalExpress. 
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Configurazione di 
ClinicalExpress®

 

 

Introduzione 
 
In questo capitolo vengono descritte le operazioni amministrative che possono 
essere eseguite con ClinicalExpress: 

 Accesso alla finestra Amministrazione (Administration). 

 Impostazione dei parametri della workstation locale. 

 Impostazione dei parametri di visualizzazione. 

 Impostazione dei valori di risoluzione del digitalizzatore. 

 Impostazione delle opzioni di elaborazione delle immagini. 

 Definizione delle visualizzazioni per le mammografie. 

 Definizione dei campi dati obbligatori. 

 Gestione degli account utente. 

 Selezione dei campi dati per l'anonimizzazione. 

 Backup e ripristino della licenza. 

 Definizione delle destinazioni. 

 Verifica della configurazione del digitalizzatore di pellicole. 

 Controllo della disponibilità di Modality Worklist. 

 Verifica e gestione del file di registro. 

 Calibratura del digitalizzatore di pellicole. 
 
Questo capitolo fornisce inoltre istruzioni di base per la calibratura del monitor di 
una workstation. 
 
Se si sta impostando ClinicalExpress per la prima volta, seguire tutte le sezioni di 
questo capitolo ed eseguire tutte le operazioni che si applicano alle funzioni di 
ClinicalExpress concesse in licenza e alla propria configurazione di sistema. 
 

Nota: per poter accedere alla finestra Amministrazione 
(Administration) di ClinicalExpress e apportarvi modifiche è 
necessario aver eseguito l'accesso come amministratore. 

 
Nota: non è possibile digitalizzare pellicole finché non viene 
definito almeno una destinazione valida. Vedere il paragrafo 
"Definizione delle destinazioni" più avanti in questo capitolo. 
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Accesso alla finestra Amministrazione (Administration) 
 
La finestra Amministrazione (Administration) di ClinicalExpress è protetta da 
password. 
 
1. Opzioni > Amministrazione (Options > Administration). 
 
 Se è stato già eseguito l'accesso a ClinicalExpress come amministratore, la 

finestra Amministrazione (Administration) sarà visibile e si può saltare il 
punto 2. Altrimenti comparirà la finestra di login: 

 

  
 
2. Inserire la Password dell'amministratore, quindi fare clic su OK. 
 
 
 

Suggerimento: il nome 
predefinito è Admin (distinzione 
tra maiuscole e minuscole) e la 
password predefinita è nessuna 
password, ossia occorre lasciare 
vuoto il campo password. 
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Impostazione dei parametri della workstation locale 
 
Impostare i parametri della workstation locale nella sottosezione Locale (Local) 
della struttura ad albero Amministrazione (Administration). 
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Parametri DICOM (DICOM Parameters) 
 

 
 
 
Il Titolo dell'entità applicazione (Application Entity - AE) è il nome utilizzato da 
altri software per identificare questa applicazione. 
 
1. Inserire il Titolo dell'entità applicazione per il dispositivo DICOM (per 

impostazione predefinita, in questo campo viene inserito “ClinicalExpress”). 
Il titolo dell'AE fa distinzione tra maiuscole e minuscole. 

 
2. Nel campo Numero porta (Port Number), inserire il numero porta per questo 

dispositivo DICOM (per impostazione predefinita, in questo campo viene 
inserito “207”). 

 
3. Fare clic sul pulsante Applica (Apply). 
 
 
Registro (Log) 
 

 
 
 
1. Modificare le impostazioni del registro secondo necessità: 
 
 Livello di registro (Log Level) specifica il tipo di informazioni 

visualizzabili nella finestra Registro degli errori (Error Log): 
 INFORMAZIONI (INFORMATION) mostra le informazioni DICOM 

e su ClinicalExpress. 
 AVVISI (WARNING) mostra soltanto gli errori e gli avvisi. 
 ERRORE (ERROR) mostra soltanto gli errori. 

 
 ClinicalExpress acquisisce automaticamente tutti gli errori e le 

informazioni. (Per visualizzare il registro degli errori nella sua interezza, 
aprire il file clx.log in un editor di testo). 

 
Nota: la finestra Registro degli errori (Error Log) non è uno 
strumento diagnostico DICOM completo, in quanto non registra 
le trasmissioni DICOM nella loro interezza. Si tratta 
principalmente di uno strumento di risoluzione dei problemi del 
software. 
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 Conserva le voci del registro (Keep Log Entries): Le voci presenti nel 
file di registro verranno eliminate dopo il numero di giorni selezionato. 
(Vedere il paragrafo “Modifica e gestione del file di registro”, più avanti in 
questo capitolo). 

 
2. Fare clic sul pulsante Applica (Apply). 
 
 
 
Localizzazione (Localization) 
 

 
 
1. Nel campo Lingua (Language), selezionare la lingua da utilizzare 

nell'interfaccia utente dell'applicazione. 
 
2. Nel campo Formato data (Date Format), selezionare il formato dati da 

utilizzare nell'applicazione. 
 
3. Fare clic sul pulsante Applica (Apply). 
 
4 Chiudere ClinicalExpress e avviarlo di nuovo per completare le modifiche. 
 
 
 
Sistema (System) 
 

 
 
 
1. Modificare le impostazioni come necessario (sopra vengono mostrate le 

impostazioni predefinite): 
 
 Spazio minimo sul disco (Minimum Disk Space): quando lo spazio libero 

sul disco scende al di sotto di questo valore, ClinicalExpress elimina 
automaticamente i file, iniziando dagli studi meno recenti che sono stati 
inviati correttamente. Se il programma non riesce a liberare una quantità 
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sufficiente di spazio sul disco per raggiungere il valore indicato nel campo 
Spazio minimo sul disco (Minimum Disk Space), impedirà all'utente di 
digitalizzare altre pellicole fino a quando non sarà disponibile uno spazio 
adeguato. 

 
 Lunghezza massima pellicola (Maximum Film Length): questo valore, 

normalmente impostato su 17 pollici, può essere modificato per poter 
utilizzare pellicole più lunghe. 

 
Nota: aumentare il valore riportato nel campo Lunghezza 
massima pellicola (Max Film Length) portandolo a un valore 
superiore a 17 pollici soltanto se è collegato un digitalizzatore di 
pellicole DIAGNOSTICPRO® Plus o DIAGNOSTICPRO® Advantage. 
Consultare la guida all'utilizzo del relativo digitalizzatore di 
pellicole per ottenere informazioni sulla digitalizzazione di 
pellicole più lunghe di 17 pollici. 

 

Nota: dato che il sistema utilizza una routine di 
autodimensionamento per determinare la lunghezza della 
pellicola, potrebbe non essere possibile digitalizzare pellicole 
perforate. 

 
 Riprove di trasmissione (Transmission Retries): imposta il numero 

tentativi di invio di uno studio a una destinazione da parte di 
ClinicalExpress. ClinicalExpress gestisce le trasmissioni di studi non 
riuscite nel modo seguente: 
 Se vi sono altri studi in coda di trasmissione, lo studio il cui invio è 

fallito viene posizionato in fondo alla coda e verrà effettuato un 
tentativo di invio dello studio in un secondo momento—in funzione del 
numero di nuovi tentativi di trasmissione e dell'intervallo di 
ritrasmissione (vedere sotto). 

 Se non vi sono altri studi nella coda di trasmissione, ClinicalExpress 
tenta immediatamente di inviare di nuovo lo studio in funzione del 
numero di nuovi tentativi di trasmissione e dell'intervallo di 
ritrasmissione (vedere sotto). 

 Se non è stato possibile inviare lo studio entro il numero di nuovi 
tentativi di trasmissione impostato, lo studio viene mostrato nella 
finestra Studi acquisiti (Acquired Studies) (Visualizza > Studi 
acquisiti (View > Acquired Studies)), dove è possibile effettuare una 
trasmissione manuale. 

 Agli studi il cui invio non ha avuto esito positivo viene assegnato lo 
stato "non riuscito" fino a quando l'invio non viene eseguito 
correttamente. 

 
 Intervallo di ritrasmissione (Retry Time): definisce il tempo (in minuti) 

di attesa di ClinicalExpress prima che venga effettuato un tentativo di invio 
di uno studio a una destinazione se il tentativo precedente è fallito. 

 
 Campo iniziale degli elenchi (Lists’ Start Field): controlla se il Nome 

paziente (Patient Name) o l'ID è posizionato nella prima colonna 
nell'elenco degli Studi acquisiti e nell'elenco delle Procedure della lista di 
lavoro. 
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 Percorso immagini (Images Path): se si desidera, modificare la directory 
locale predefinita per l'archiviazione delle immagini. Eseguire questa 
operazione, ad esempio, se si desidera archiviare le immagini in un'unità o 
in una partizione con maggiore capacità. Per modificare il percorso, fare 
clic sul pulsante ..., quindi selezionare un nuovo percorso. 

 
 Blocca tasti (Lock Keys): quando questa funzione è attivata, 

ClinicalExpress disasbilita i tasti (ad esempio ALT-TAB) che 
consentirebbero a un utente di passare da ClinicalExpress ad altri 
programmi aperti e viceversa. 

 
 Abilita cronologia aggiuntiva paziente (Enable Additional Patient’s 

History): quando questa funzione è attivata, ClinicalExpress mostra il 
campo Cronologia aggiuntiva paziente (Additional Patient History) nella 
parte inferiore della finestra Informazioni sullo studio (Study 
Information). 

 

Finestra Informazioni su paziente/studio/serie 
(Patient/Study/Series Information) senza Cronologia  
aggiuntiva paziente (Additional Patient History) 

Finestra Informazioni su paziente/studio/serie 
(Patient/Study/Series Information) con Cronologia  
aggiuntiva paziente (Additional Patient History) 

 

 Genera automaticamente numero di collocamento (Auto Generate 
Accession Number): quando questa opzione è attivata, ClinicalExpress 
inserisce automaticamente il numero di collocamento successivo in 
sequenza nella finestra Informazioni sullo studio (Study Information) 
quando l'utente crea un nuovo studio. Il numero di collocamento inserito 
può essere modificato. 

 
 Invia numero di collocamento vuoto (Send Empty Accession Number): 

quando questa opzione è attivata, ClinicalExpress non invia i numeri di 
collocamento alle destinazioni. 

 
 Invia ID dimensione pellicola (Send Film Size ID): quando questa 

opzione è attivata, ClinicalExpress invia le dimensioni della pellicola alle 
destinazioni. 

 
 Invia ogni immagine come serie (Send each image as a Series): quando 

questa opzione è attivata, ogni immagine viene inviata come serie. Quando 
è disattivata, una serie può includere più immagini. 
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 Imposta tipo immagine come DERIVATA\PRIMARIA (Set Image Type 
as DERIVED\PRIMARY): quando questa opzione è attivata, a ogni 
immagine verrà assegnato un tag per l'utilizzo nei sistemi mammografici 
GE. 

 

2. Fare clic sul pulsante Applica (Apply). 
 
 
 
Logout automatico (Auto logout) 
 

 
 
Quando questa opzione è attivata, ClinicalExpress si chiude automaticamente  
se non rileva nessuna attività da parte dell'utente (tastiera o mouse) dopo il  
tempo indicato. 
 
Dopo aver effettuato le modifiche, fare clic sul pulsante Applica (Apply). 
 
 
 
Elimina dopo invio (Delete after send) 
 

 
 
Quando questa opzione è attivata, ClinicalExpress elimina i pazienti e/o le 
immagini circa 10 minuti dopo che questi sono stati trasmessi correttamente alla 
destinazione. Considerazioni: 
 Quando sono attivate, queste opzioni impediscono che il disco della 

workstation si riempia di file immagine. Tuttavia, gli studi inviati 
immediatamente dopo l'acquisizione e poi eliminati non verranno riportati 
nella finestra Studi acquisiti (Acquired Studies), quindi non possono essere 
successivamente inviati alla stessa destinazione o ad altre destinazioni. 

 Quando queste opzioni sono disattivate, gli studi vengono riportati nella 
finestra Studi acquisiti (Acquired Studies) e possono essere successivamente 
inviati ad altre destinazioni. Tuttavia, gli studi si accumuleranno sul disco 
della workstation e potrebbero riempirlo. 

 Il database di ClinicalExpress ha un limite di 10 GB. Una volta raggiunto tale 
limite, è necessario eliminare immagini e pazienti per continuare a 
digitalizzare pellicole. 

 
Dopo aver effettuato le modifiche, fare clic sul pulsante Applica (Apply). 
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Elimina dopo conferma archiviazione (Delete After Storage 
Commitment) 
 

 
 
Quando questa opzione è attivata, ClinicalExpress cancella i pazienti e/o le 
immagini solo dopo aver ricevuto un messaggio di conferma archiviazione da 
una destinazione. Il messaggio conferma che la destinazione non soltanto ha 
ricevuto il documento trasmesso, ma lo ha anche archiviato. Per maggiori 
dettagli, vedere sopra il paragrafo “Elimina dopo invio” (Delete After Send). 
 
Dopo aver effettuato le modifiche, fare clic sul pulsante Applica (Apply). 
 
 
 
Interfaccia utente predefinita all'avvio (Default Startup GUI) 
 

 
 
Questa opzione specifica quale modalità viene visualizzata all'avvio di 
ClinicalExpress. Se si è in possesso delle licenze sia per la modalità Radiografia 
generale che per la modalità Mammografia, gli utenti potranno passare da una 
modalità all'altra. 
 
Dopo aver effettuato le modifiche, fare clic sul pulsante Applica (Apply). 
 
 
 
Riempimento automatico studio (Auto Fill Study) 
 

 
 
Quando questa opzione è attivata, la data e/o l'ora correnti vengono 
automaticamente inserite in un nuovo studio. 
 
Dopo aver effettuato le modifiche, fare clic sul pulsante Applica (Apply). 
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Impostazione dei parametri di visualizzazione 

Impostare i parametri di visualizzazione nella sottosezione Locale | 
Impostazioni di visualizzazione (Local | Display Settings) della struttura ad 
albero Amministrazione (Administration). 

 

Impostazioni di visualizzazione predefinite 

Le impostazioni di visualizzazione applicano automaticamente le regolazioni di 
finestre e livelli a un'immagine in base alla parte del corpo e alla modalità 
selezionata dall'utente. Le impostazioni riguardano il tipo di pellicola, il tipo di 
digitalizzatore e la profondità di bit. Nella schermata riportata sopra vengono 
mostrate quattro impostazioni di visualizzazione predefinite. Questa sezione della 
finestra Amministrazione (Administration) consente di definire, modificare ed 
eliminare le impostazioni di visualizzazione. 
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 Per creare una nuova impostazione di visualizzazione: 
 

a. Fare clic sul pulsante Nuovo (New). 
 
b. Fare clic nel campo Modalità (Modality), quindi digitare la modalità. 

 oppure 
Selezionare una modalità esistente dall'elenco. 

 
c. Fare clic nel campo Visualizzazione (View), quindi digitare la 

visualizzazione. 
  oppure 
 Selezionare una visualizzazione esistente dall'elenco. 
 
d. Inserire le impostazioni di finestra e di livello per una profondità di bit. 

ClinicalExpress calcola e compila automaticamente i valori corrispondenti 
per le due altre profondità di bit. 

 

  

Finestra Livello 
 

 

Finestra Livello 
 
e. Fare clic sul pulsante Salva (Save). 

 
Nota: ClinicalExpress dispone di impostazioni di finestra e 
livello precalcolate per Parte del corpo (Body Part) = DEFAULT 
e Modalità (Modality) = DEFAULT. Inizialmente, vengono 
applicate queste impostazioni alle immagini. L'utente può 
sovrascrivere le impostazioni utilizzando lo strumento di 
modifica del livello e della finestra controllato tramite mouse, 
oppure inserendo i valori nelle caselle Finestra (Window) e 
Livello (Level) presenti nella finestra principale, oppure ancora 
utilizzando i valori di finestra/livello preimpostati. 
L'amministratore può modificare le impostazioni predefinite 
(elencate a sinistra) nel modo descritto di seguito. 
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 Per modificare i valori di finestra e livello per un'impostazione di 
visualizzazione esistente: 

 
a. Fare clic sulla riga che si desidera modificare. 
 
b. Fare clic sul pulsante Modifica (Edit). 
 
c. Modificare il valore di finestra (campo a sinistra) e/o il valore di livello 

(campo a destra) per una profondità di bit. ClinicalExpress calcola e 
compila automaticamente i valori corrispondenti per le due altre profondità 
di bit. 

 
d. Fare clic sul pulsante Salva (Save). 

 
 
 Per eliminare un'impostazione di visualizzazione esistente: 
 

a. Fare clic sulla riga che si desidera eliminare. 
 
b. Fare clic sul pulsante Elimina (Delete). 

 
 
 Per applicare automaticamente le regolazioni di finestra e di livello in base 

alla dimensione della pellicola e alla risoluzione dell'immagine: attivare la 
funzione Abilita finestra/livello automatici (Enable Auto Window/Level). 
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Impostazione dei valori di risoluzione del digitalizzatore 
 
Impostare i valori di risoluzione del digitalizzatore nella sottosezione Locale | 
Impostazioni digitalizzatore (Local | Digitizer Settings) della struttura ad albero 
Amministrazione (Administration). 
 

 
 
 
Le impostazioni del digitalizzatore definiscono automaticamente la risoluzione 
delle immagini in base alla larghezza della pellicola. 
 
 Per modificare una risoluzione: 
 

a. Fare clic sulla riga che contiene la dimensione della pellicola che si 
desidera modificare. 

 
b. Fare doppio clic nella colonna Risoluzione (Resolution) di quella riga. 
 
c. Selezionare la risoluzione desiderata. 
 
d. Fare clic sul pulsante Salva (Save). 
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Impostazione delle opzioni di elaborazione delle immagini 
 
Impostare le opzioni di elaborazione nella sottosezione Locale | Elaborazione 
immagini (Local | Image Processing) della struttura ad albero Amministrazione 
(Administration). 
 

 
 
 

Nota: per impostazione predefinita, i valori di impostazione 
nella finestra Elaborazione immagini (Image Processing) sono 
disattivati. 
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Nota: ClinicalExpress applica automaticamente e 
permanentemente le operazioni di elaborazione delle immagini 
controllate a ciascuna immagine immediatamente dopo 
l'acquisizione dal digitalizzatore (quindi prima che venga 
visualizzata o inviata). Gli utenti non possono rimuovere i 
risultati dell'elaborazione delle immagini. Se non è necessaria 
l'elaborazione delle immagini, l'amministratore deve 
deselezionare le opzioni presenti nella pagina Elaborazione 
immagini (Image Processing), quindi l'utente deve 
ridigitalizzare le pellicole per produrre nuove immagini. 

 
1. Impostare le opzioni di elaborazione delle immagini nel modo richiesto: 
 
 Maschera di contrasto (Unsharp Mask): quando questa opzione è attivata, 

ClinicalExpress applica l'algoritmo maschera di contrasto per mettere a 
fuoco i dettagli dell'immagine. Selezionare Basso (Low), Medio (Medium) 
o Alto (High) per controllare il livello di messa a fuoco. 

 
 Compressione della gamma dinamica (DRC) (Dynamic Range 

Compression): quando questa opzione è attivata, ClinicalExpress applica 
un filtro non lineare per comprimere la gamma dinamica di un'immagine. 
Selezionare Basso (Low), Medio (Medium) o Alto (High) per controllare 
il livello di compressione. 

 
 Elaborazione post digitalizzazione (Post-Digitization Processing): 
 Raddrizza immagine dopo digitalizzazione (Straighten Image After 

Digitization): quando questa opzione è attivata, le immagini che 
superano il Valore di soglia (Threshold Value) vengono 
automaticamente raddrizzate dopo la cattura. Quando è disattivata, 
l'utente può raddrizzare le immagini nella finestra di ClinicalExpress. 

 Valore di soglia (Threshold Value): l'immagine deve essere ruotata di 
un valore superiore a questo per poter essere raddrizzata 
automaticamente. 

 Ripristina (Reset): fare clic per ripristinare i valori di soglia predefiniti. 
 

Nota: la funzione di raddrizzamento automatico delle immagini 
presume che i bordi della pellicola siano rettilinei e ad angolo 
retto. Deselezionare questa opzione se le pellicole sono state 
tagliate. 

 
 LUT monitor (Monitor LUT): quando questa funzione è attivata, 

ClinicalExpress applica valori di Look Up Table all'immagine prima di 
visualizzarla. 
 Da file (From File): selezionare questa opzione se la Look Up Table è 

disponibile come file. Inserire il percorso e il nome del file oppure fare 
clic sul pulsante di navigazione per designare il file. 

 Genera usando densità (Generate Using Density): selezionare questa 
opzione per fare in modo che ClinicalExpress generi una Look Up Table 
in base al valore di densità specificato. 
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 Applica funzioni di visualizzazione standard (Apply SDF): quando 
questa funzione è attivata, ClinicalExpress applica all'immagine i valori 
delle Funzioni di visualizzazione standard prima che l'immagine venga 
visualizzata, utilizzando i valori di Illuminazione (Illumination), Luce 
ambientale (Ambient Light), Densità minima del digitalizzatore (DMax 
- digitizer’s minimum density) e Densità massima del digitalizzatore 
(DMax - digitizer’s maximum density). 

 
2. Fare clic sul pulsante Applica (Apply). 
 
 

Valori SDF DICOM predefiniti 

Illuminazione 2000 cd/m2 

Luce ambientale 10 cd/m2 

DMin 0 

DMax 255 
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Definizione delle visualizzazioni per le mammografie 
Le visualizzazioni offrono agli utenti di ClinicalExpress dei protocolli di 
visualizzazione per assemblare immagini mammografiche distinte in immagini 
composite. ClinicalExpress è provvisto di un protocollo 2x2 predefinito. È 
possibile definire altre visualizzazioni se necessario. 

Nota: l'opzione che consente di eseguire scansioni di 
documenti per le mammografie è stata aggiunta in 
ClinicalExpress 6.0. Se non si dispone dell'opzione PDI, è 
necessario aggiungerla per poter eseguire la scansione dei 
documenti utilizzando uno scanner a lastra. È inoltre necessario 
definire un layout in cui l'opzione Visualizzazione pellicole 
(Film View) è impostata su CARTA (PAPER). 

Definire le visualizzazioni nella sottosezione Locale | Mammografia (Local | 
Mammography) della struttura ad albero Amministrazione (Administration). 
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1. Fare clic sul pulsante Nuovo (New). 
 
2. Nell'elenco Visualizzazioni (Views), fare clic sulla colonna Nome (Name), 

digitare un nome per il layout, quindi premere INVIO. 
 

 
 
3. Aprire l'elenco dei Layout, quindi fare clic sul layout riga x colonna 

desiderato. 
 
4. Nell'elenco Ordine visualizzazione (View Order), definire il campo 

Visualizzazione pellicola (Film View) per ciascuna cella. L'Anteprima 
layout mostra in che modo vengono assegnate le visualizzazioni delle 
pellicole alle celle. 

 

  
 
 

Nota: per eseguire la scansione dei documenti, impostare 
Visualizzazione pellicola (Film View) su CARTA (PAPER). 

 
Nota: l'opzione Orientamento paziente (Patient Orientation) 
viene impostata automaticamente quando viene selezionata 
una Visualizzazione pellicola (Film View) e non va modificata. 

 
Nota: gli utenti possono sovrascrivere l'Orientamento paziente 
(Patient Orientation) impostato in questo campo. 

 
 
 Per eliminare una visualizzazione: 

a. Nell'elenco Visualizzazioni (Views), fare clic sulla visualizzazione, quindi 
fare clic sul pulsante Elimina (Delete). 

b. Confermare l'eliminazione. 
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 Per modificare una visualizzazione: 
a. Nell'elenco Visualizzazioni (Views), fare clic sulla visualizzazione, quindi 

fare clic sul pulsante Modifica (Edit). 
b. Nell'elenco Visualizzazioni (Views), fare clic sul Nome (Name), quindi 

digitare un nuovo nome. 
c. Nell'elenco Ordine visualizzazione (View Order), modificare i campi 

Visualizzazione pellicola (Film View) e Orientamento paziente (Patient 
Orientation) se necessario. 

d. Fare clic sul pulsante Salva (Save). 
 

Nota: è possibile eliminare o modificare una visualizzazione 
solo se non è citata in uno studio. 

 
 
Visualizzazioni ed orientamenti paziente 
 
L'esempio seguente mostra il rapporto esistente tra visualizzazioni, immagini e 
orientamenti paziente. 
 
Ipotizziamo di definire due visualizzazioni nel modo seguente: 
 
Visualizzazione A 

Riga Colonna Visualizzazione 
pellicola 

Orientamento 
paziente 

1 1 RCC PF 

1 2 LCC AF 

2 1 RLMO AFL 

2 2 LMLO PFL 

 
Visualizzazione B 

Riga Colonna Visualizzazione 
pellicola 

Orientamento 
paziente 

1 1 RCC FL 

1 2 LCC PF 

2 1 RLMO PFL 

2 2 LMLO FR 

 
Le immagini poste nelle celle ricevono gli orientamenti paziente predefiniti. 
Ipotizziamo che sia attiva la Visualizzazione A. L'immagine presente nella riga 1, 
colonna 1 (RCC) avrà l'orientamento PF predefinito. 
 
Ipotizzando che l'utente faccia clic con il pulsante destro del mouse su 
un'immagine, ne modifichi l'orientamento in PF, quindi trascinasse l'immagine 
nella riga 2, colonna 2 (LMLO). L'immagine sovrascrive l'orientamento PFL 
predefinito e mantiene l'orientamento PF assegnato dall'utente. 
 
Supponiamo ora che l'utente selezioni la Visualizzazione B per questo stesso 
studio. Questa azione applica gli orientamenti del paziente predefiniti della 
Visualizzazione B alle immagini. L'immagine in RCC, ad esempio, ora avrà 
l'orientamento paziente FL. 
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Supponiamo che l'utente chiuda lo studio. In questo caso, l'amministratore 
modifica la Visualizzazione B, cambiando l'orientamento paziente RCC in AF. Se 
lo studio viene riaperto, l'immagine RCC mostra l'orientamento paziente FL 
(salvato nello studio quando è stato chiuso), non AF (nuovo orientamento RCC 
predefinito AF). Tuttavia, se viene aggiunta una nuova immagine nella cella 
RCC, il suo orientamento paziente sarà l'AF predefinito. 
 
 
 
Creazione di codici di visualizzazione personalizzata e codici 
di modifica visualizzazione personalizzata 
 
È possibile creare codici di visualizzazione personalizzata, che compariranno 
nell'elenco a discesa presente nella colonna Visualizzazione pellicole (Film 
View) dell'elenco Ordine di visualizzazione (View Order) nella sottosezione 
Locale | Mammografia (Local | Mammography) della struttura ad albero 
Amministrazione (Administration) (descritto in precedenza in questo capitolo). 
È inoltre possibile creare codici di modifica visualizzazione personalizzata che 
sono associati ai codici di visualizzazione personalizzata. 
 

Nota: al momento della pubblicazione del presente manuale, i 
codici di visualizzazione personalizzata e i codici di modifica 
visualizzazione personalizzata non erano definiti da DICOM o 
IHE. Lo sviluppo, l'uso e l'affidabilità dei codici di visualizzazione 
e dei codici di modifica visualizzazione personalizzata sono di 
esclusiva competenza dell'utente di ClinicalExpress. 

 
 Per creare un codice di visualizzazione personalizzata: 

1. Nella sottosezione Locale | Mammografia (Local | Mammography) della 
struttura ad albero Amministrazione (Administration), fare clic sul 
pulsante Personalizza (Custom). Si aprirà la finestra Personalizza 
visualizzazioni mammografia (Customize Mammography Views) (vedere 
pagina seguente). 

2. Nella sezione Codici di visualizzazione personalizzata (Custom View 
Codes), fare clic sul pulsante Nuovo (New). 

3. Fare clic in ogni colonna e inserire le relative informazioni. 
4. Fare clic su Salva (Save). 
 

 Per modificare un codice di visualizzazione personalizzata: 
1. Nella sezione Codici di visualizzazione personalizzata (Custom View 

Codes), fare clic sul codice di visualizzazione che si desidera modificare. 
2. Fare clic su Modifica (Edit). 
3. Modificare le informazioni secondo necessità. 
4. Fare clic su Salva (Save). 
 

 Per eliminare un codice di visualizzazione personalizzata: fare clic sul codice 
di visualizzazione che si desidera eliminare, quindi fare clic su Elimina 
(Delete). 
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Nota: i codici di visualizzazione personalizzata possono essere 
modificati o eliminati solo se non sono citati in un layout di 
visualizzazione. 

 
 Per creare un codice di modifica visualizzazione personalizzata: 

1. Nella sezione Codice di modifica visualizzazione personalizzata 
(Custom View Modifier Code), fare clic sul pulsante Nuovo (New). 

2. Fare clic in ogni colonna e inserire le relative informazioni. 
3. Fare clic su Salva (Save). 
 

 Per modificare un codice di modifica visualizzazione personalizzata: 
1. Nella sezione Codici di modifica visualizzazione personalizzata (Custom 

View Modifier Codes), fare clic sul codice di modifica visualizzazione che 
si desidera modificare. 

2. Fare clic su Modifica (Edit). 
3. Modificare le informazioni secondo necessità. 
4. Fare clic su Salva (Save). 
 

 Per eliminare un codice di modifica visualizzazione personalizzata: fare clic 
sul codice di modifica visualizzazione che si desidera eliminare, quindi fare 
clic su Elimina (Delete). 

 
Nota: i codici di modifica visualizzazione personalizzata 
possono essere modificati o eliminati solo se non sono citati in 
un layout di visualizzazione personalizzata. 

 
Nota: durante l'archiviazione e l'esportazione DICOM, vengono 
aggiunti codici di visualizzazione personalizzata all'intestazione 
dell'immagine DICOM nel formato Sequenza di codici di 
visualizzazione (0054, 0222). Tutti i codici di modifica 
visualizzazione sono inviati come Sequenza di codici di modifica 
visualizzazione (0054, 0220), che fa parte della Sequenza di 
codici di visualizzazione. 
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Definizione dei campi dati obbligatori 
 
I campi dati presenti nelle finestre Informazioni sul paziente (Patient 
Information) e Informazioni sullo studio (Study Information) possono essere 
definiti come obbligatori (indicati con il nome del campo in grassetto) a seconda 
delle politiche vigenti nella propria organizzazione. 
 
Impostare i campi dati obbligatori nella sottosezione Locale | Campi obbligatori 
(Local | Mandatory Fields) della struttura ad albero Amministrazione 
(Administration). 
 

 
 
 
1. Impostare i campi obbligatori nel modo seguente: 
 
 Per rendere obbligatoria la compilazione di un determinato campo: 

Selezionare la casella presente nella colonna Obbligatorio (Mandatory). 
 
 Per rendere opzionale la compilazione di un determinato campo: 

Deselezionare  la casella presente nella colonna Obbligatorio 
(Mandatory). 

 
2. Fare clic sul pulsante Applica (Apply). 
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Gestione degli account utente 
 
La finestra Gestione utenti (User Manager) consente agli amministratori di 
ClinicalExpress di aggiungere, modificare ed eliminare gli account utente. 
 

Nota: a tutti gli utenti di ClinicalExpress devono essere 
assegnati privilegi di tipo “Power user” in Windows 2000 o 
Windows XP. 

 
Aggiungere, modificare o rimuovere account utente nella sezione Locale | 
Gestione utenti (Local | User Manager) della finestra Amministrazione 
(Administration). Le istruzioni sono riportate nella pagina seguente. 
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 Per aggiungere un account utente: 

 
a. Fare clic sul pulsante Aggiungi (Add). Si aprirà la finestra Informazioni 

utente (User Information). 
 

  
 
b. Inserire il Nome utente (User Name) (ovvero il nome per il login), il 

Nome completo (Full Name) e la Descrizione (Description) (ad esempio 
la qualifica) del nuovo utente. Inserire una Password per l'utente, quindi 
inserirla di nuovo in Conferma password (Confirm Password). 

 
c. Fare clic su Crea (Create). 
 
 

 Per modificare il nome completo, la descrizione o la password di un utente: 
 
a. Nell'elenco degli utenti, fare clic sulla riga dell'account del relativo utente. 
 
b. Fare clic sul pulsante Modifica (Edit). 
 

  
 
c. Modificare le informazioni secondo necessità. 
 
d. Fare clic su Salva (Save). 
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Nota: non è possibile modificare il nome per il login dell'utente 
(Nome utente (User Name)). Per modificare un nome utente, 
eliminare l'account di quell'utente e creare un nuovo account 
utente come descritto sopra. 

 
Nota: la password dell'Amministratore può essere modificata 
ma il nome utente dell'Amministratore non può essere 
modificato. Conservare la password dell'Amministratore in un 
luogo sicuro. 

 
 

 Per rimuovere un account utente: 
 
a. Nell'elenco degli utenti, fare clic sulla riga dell'account del relativo utente. 
 
b. Fare clic sul pulsante Rimuovi (Remove). 

 
Nota: l'account utente “Admin” non può essere eliminato. 

 
 
 
Le password non possono essere recuperate. Se un utente dimentica la propria 
password è necessario eliminare l'account dell'utente e creare un nuovo account. 
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Selezione dei campi dati per l'anonimizzazione 
 
Per tutelare la privacy dei pazienti, i dati presenti in campi selezionati possono 
essere resi anonimi (rimossi o sostituiti da valori fissi) quando gli studi vengono 
inviati a una destinazione. I dati originali salvati nel database di ClinicalExpress 
non vengono modificati quando vengono resi anonimi durante la trasmissione. 
 
L'impostazione di anonimizzazione dei dati include due punti: 
1. Designazione dei campi da rendere anonimi, descritta in questa sezione. 
2. Attivazione dell'opzione Rendi anonimo (Anonymize) per le destinazioni, 

descritta nel prossimo paragrafo di questo capitolo, dal titolo “Definizione 
delle destinazioni”. 

 
Aggiungere, modificare o rimuovere campi anonimi nella sezione Locale | Rendi 
anonimo (Local | Anonimyze) della finestra Amministrazione (Administration). 
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 Per designare un campo da rendere anonimo: 
 

a. Fare clic sul pulsante Aggiungi (Add). Si aprirà la finestra Informazioni 
sull'elemento da rendere anonimo (Anonymizer Element Information). 

 

  
 
b. Aprire l'elenco Nome (Name) e fare clic sul campo da rendere anonimo. È 

possibile rendere anonimi i seguenti campi: 
 Nome paziente 
 ID paziente 
 Data di nascita 
 Sesso paziente 
 Numero di collocamento 
 Data studio 
 Ora studio 
 Descrizione studio 
 Descrizione serie 
 

 Descrizione diagnosi di ricovero 
 Nome medico referente 
 Nome istituto 
 Modalità 
 Produttore 
 ID studio 
 Numero serie 
 Numero richiesta 
 Tipo conversione 
 Parte del corpo esaminata 

 
c. Opzionale: inserire un Valore (Value) per sostituire i dati del paziente.  

Se non viene inserito nessun valore, il campo sarà vuoto dopo che verrà 
reso anonimo. 

 
d. Fare clic su OK. 

 Per modificare i valori da rendere anonimi per un campo: 
 

a. Fare clic sulla riga in cui è presente il campo da modificare. 
 

b. Fare clic sul pulsante Modifica (Edit). 
 

c. Nella finestra Informazioni sull'elemento da rendere anonimo 
(Anonymizer Element Information), modificare il Valore (Value). 

 

d. Fare clic su OK. 

 Per rimuovere l'anonimizzazione per un campo: 
 

a. Fare clic sulla riga da rimuovere. 
 

b. Fare clic sul pulsante Rimuovi (Remove). 
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Backup e ripristino della licenza 
 
È disponibile un backup della licenza per le installazioni di ClinicalExpress. 
Questa funzione va impostata subito dopo l'installazione di ClinicalExpress. 
Consente di salvare il codice di licenza in un luogo sicuro, ad esempio una 
cartella di rete o in un'unità flash (unità di memoria USB), per consentire il 
ripristino della licenza in caso di problemi hardware o software sul computer. 
 
Il file di backup della licenza registra il numero di scansioni residue e la durata 
della licenza. Questo file viene ricreato ogni 24 ore con gli ultimi dati relativi alle 
scansioni e all'ora, sovrascrivendo la copia precedente (per questa ragione, non è 
possibile effettuare il backup su un CD o DVD). Se ClinicalExpress non è aperto 
nel momento in cui è pianificato un backup, il backup verrà eseguito al 
successivo avvio dell'applicazione. 
 

Backup della licenza 
 
Per eseguire il backup della licenza andare alla sezione Locale | Backup licenza 
(Local | License Backup) della finestra Amministrazione (Administration). 
 

 
 
 
 Per eseguire il backup della licenza: 
 

a. Attivare l'opzione Abilita backup licenza (Enable License Backup). 

b. Fare clic sul pulsante Altro  (More), quindi selezionare la posizione in 
cui si desidera salvare la licenza. 

 
Nota: non selezionare una posizione sul computer locale. 
Selezionare una posizione tipo cartella di rete o un'unità flash 
che è costantemente collegata al computer e che non verrà 
interessata da eventuali problemi del computer o se il computer 
stesso dovesse essere sostituito. 

 
c. Fare clic sul pulsante Esegui backup licenza (Backup License). 
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Ripristino della licenza 
 
Se si verifica un problema hardware o software sul computer in cui è installato 
ClinicalExpress e se è stata attivata l'opzione di backup licenza (descritta nella 
pagina precedente), VIDAR può ripristinare la licenza. 
 
1. Aprire un nuovo messaggio e-mail. 
 
2. Nel campo A del messaggio inserire “medtech@vidar.com”. 
 
3. Individuare il file di backup della licenza (con estensione .ref) e allegarlo al 

messaggio. 
 
4. Nel corpo del messaggio, descrivere la situazione e richiedere il ripristino 

della licenza. 
 
5. Inviare il messaggio. 
 
6. Dopo aver ricevuto una risposta contenente la licenza ripristinata, installare la 

licenza stessa come descritto al punto 2 del paragrafo “E. Ottenere un codice 
di licenza ClinicalExpress” nel capitolo “Installazione di ClinicalExpress” di 
questo manuale. 

 
Se non è possibile fornire una copia della propria licenza, sarà necessario 
acquistare una nuova licenza. 
 
 
 



 Configurazione di ClinicalExpress 52 

19749-001 Rev. B ClinicalExpress 6.1 - Guida dell'amministratore 

Definizione delle destinazioni 
 
Gli amministratori possono impostare, modificare ed eliminare i parametri 
relativi a destinazioni e dispositivi remoti. Una destinazione è una destinazione di 
studi e/o una sorgente di dati Modality Worklist (Modality Worklist può essere 
acquistato separatamente). 
 
La gestione delle destinazioni viene effettuata nella sottosezione Destinazioni 
(Targets) della struttura ad albero Amministrazione (Administration). 
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Creazione di una nuova destinazione 

1. Fare clic sul pulsante Nuovo (New). Si aprirà la pagina Nuova destinazione 
(New Target). 

  
 
2. Nella sezione Destinazione (Target): 
 

  
 
a. Inserire il Nome (Name) della destinazione. Scegliere un nome chiaro e 

breve, ad esempio “Clinica” o “Dr. Rossi”. Scegliere nomi che non creino 
confusione negli utenti. 
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Nota: dopo avere inserito il nome e salvato la destinazione, il 
nome non può essere modificato. Per cambiare il nome e 
necessario cancellare la destinazione e crearne una nuova. 

 
b. Selezionare il Tipo (Type) di destinazione. È possibile scegliere tra: 
 MEMORIA DICOM (DICOM STORE) 
 CONFERMA MEMORIZZAZIONE (STORAGE COMMITMENT) 
 FASE PROCEDURA ESEGUITA DALLA MODALITÀ  

(MODALITY PERFORMED PROCEDURE STEP) 
 STAMPANTE DICOM (DICOM PRINTER) 
 STAMPANTE POSTSCRIPT (POSTSCRIPT PRINTER) 
 CD DICOM (DICOM CD) 
 MODALITY WORKLIST (MODALITY WORK LIST) 
 QUERY PAZIENTE DICOM (DICOM PATIENT QUERY) 

 
Nota: il campo Tipo (Type) controlla quali campi possono 
essere modificati nelle sezioni di sinistra della finestra Nuova 
destinazione (New Target) e controlla i campi visibili nella 
sezione di destra Configurazione (Configuration). 

 
c. (Opzionale) Nel campo Desc, inserire una descrizione della destinazione. 
 
d. Per designare questa destinazione come predefinita: Attivare l'opzione 

Predefinita (Default). Le informazioni relative alla destinazione 
predefinita compaiono nella sezione Destinazione (Target) della finestra 
principale di ClinicalExpress all'avvio del programma e quando l'utente fa 
clic sul pulsante Destinazione predefinita (Default Target). 

 
Suggerimento: se la workstation invierà studi a una sola 
destinazione, o se nella maggior parte dei casi la destinazione 
sarà una sola, impostare quella destinazione come predefinita. 

 
e. Per rendere anonimi i dati inviati a questa destinazione: attivare l'opzione 

Rendi anonimo (Anonymize). Campi selezionati per l'anonimizzazione 
nella finestra Locale | Rendi anonimo (Local | Anonymize) (vedere il 
paragrafo precedente di questo capitolo: “Selezione dei campi dati da 
rendere anonimi”). 

 
f. Per consentire la compressione JPEG baseline senza perdite per questa 

destinazione: attivare Consenti compressione senza perdite (Allow 
Lossless Compression). 
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3. Nella sezione Comunicazione (Communication): 
 

  
 

a. Inserire il Titolo AE (AE Title) (Titolo dell'entità applicazione) della 
destinazione remota. I titoli AE prevedono la distinzione tra maiuscole e 
minuscole. 

 
b. Inserire la Dimensione della PDU (PDU Size) (dimensione della Protocol 

Data Unit) della destinazione in byte. Questa opzione specifica la 
dimensione massima del blocco che la destinazione può ricevere da 
ClinicalExpress. 

 
Nota: il Titolo AE (AE Title) e la Dimensione della PDU (PDU 
Size) sono di norma definiti dal programma di ricezione. 

 
c. Inserire il Tempo di attesa per le risposte (Response Timeout) desiderato 

in minuti. Questa opzione indica il lasso di tempo di attesa di una risposta 
da parte di ClinicalExpress dopo l'invio di una comunicazione alla 
destinazione. In caso di traffico di rete molto intenso, il funzionamento di 
ClinicalExpress verrà rallentato. Il valore massimo è di 5 minuti. Per 
specificare un tempo di attesa infinito, inserire 0. 

 
d. Inserire il numero della Porta (Port) dell'applicazione ricevente (ad es. 

104, 4006). 
 
e. Inserire il Nome host (Host Name) o l'indirizzo IP dell'applicazione 

ricevente. 
 
f. In caso di accesso alla destinazione mediante connessione dial-up, attivare 

Dial-up e inserire le informazioni richieste. 
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4. La sezione Digitalizzatore (Digitizer) consente di impostare la profondità di 
bit e la risoluzione predefinite e di controllare se gli utenti possono 
sovrascrivere i valori predefiniti. La Profondità di bit (Bit Depth) predefinita 
è 16 e la Risoluzione (Resolution) è 570. Nella sezione Digitalizzatore 
(Digitizer): 

 

  
 

a. Per abilitare la funzione che consente di impostare la risoluzione in base 
alla dimensione della pellicola: attivare l'opzione Imposta risoluzione in 
base a dimensione pellicola (Set Film Size Based Resolution). 

 
b. Per modificare la profondità di bit e la risoluzione predefinite: attivare 

l'opzione Abilita profondità di bit e risoluzione (Enable Bit Depth and 
Resolution), quindi impostare Profondità di bit (Bit Depth) e Risoluzione 
(Resolution) sui valori richiesti. (I valori disponibili dipendono dal 
digitalizzatore collegato). 

 
c. Per consentire agli utenti di sovrascrivere la profondità di bit e la 

risoluzione predefinite: attivare (o lasciare attivata) l'opzione Abilita 
profondità di bit e risoluzione (Enable Bit Depth and Resolution). 
Considerazioni: 
 Disattivare l'opzione Abilita profondità di bit e risoluzione (Enable 

Bit Depth and Resolution) se è necessario che la destinazione riceva 
immagini acquisite a una profondità di bit e a una risoluzione 
specifiche. Questa è la configurazione raccomandata se non si utilizza 
l'opzione Imposta risoluzione in base a dimensione pellicola (Set 
Film Size Based Resolution). 

 Attivare l'opzione Abilita profondità di bit e risoluzione (Enable Bit 
Depth and Resolution) se la destinazione è in grado di leggere immagini 
acquisite a qualsiasi profondità di bit e risoluzione disponibili, e se 
l'utente/gli utenti di ClinicalExpress sono informati su come selezionare 
le impostazioni idonee per uno studio e una destinazione specifici. 

 
Nota: ciascuna struttura ha la responsabilità di garantire che la 
profondità in bit e la risoluzione siano clinicamente appropriate 
alle immagini e agli studi per i quali si utilizza ClinicalExpress. 
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5. Le opzioni presenti nella sezione Configurazione  (Configuration) dipendono 
dal Tipo (Type) di destinazione selezionata. Seguire le istruzioni relative al 
Tipo (Type) di destinazione selezionata: 

 
 
 Per il Tipo (Type) di destinazione MEMORIA DICOM (DICOM STORE): 
 

  
 

a. Se è disponibile una Look Up Table per la destinazione, attivare LUT, 
quindi fare clic sul pulsante ... (vedere freccia) per selezionare il file 
LUT. 

 
b. Se ClinicalExpress deve rispondere a messaggi di conferma 

archiviazione provenienti da una destinazione: 
 Attivare Conferma archiviazione (Storage Commitment). 
 Selezionare una Destinazione (Target) oppure selezionare Stesso 

(Same) per fare in modo che questa opzione venga applicata alla 
destinazione corrente. 

 Inserire un Tempo di attesa massimo (Maximum Wait Time). 
ClinicalExpress non interverrà prima di avere ricevuto un'indicazione 
di conferma archiviazione entro questo periodo di tempo. 

 
 
 Per il Tipo (Type) di destinazione CONFERMA MEMORIZZAZIONE 

(STORAGE COMMITMENT): 
 

  
 
 Inserire un Tempo di attesa massimo (Maximum Wait Time). 

ClinicalExpress non interverrà prima di avere ricevuto un'indicazione di 
conferma archiviazione entro questo periodo di tempo. 

 
 
 Per il Tipo (Type) di destinazione FASE PROCEDURA ESEGUITA 

DALLA MODALITÀ (MODALITY PERFORMED PROCEDURE 
STEP), non vi sono opzioni di configurazione. 
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 Per il Tipo (Type) di destinazione STAMPANTE DICOM  
(DICOM PRINTER): 

 

  
 

a. Se una Look Up Table è disponibile per la stampante, attivare LUT, 
quindi fare clic sul pulsante ... (vedere freccia) per selezionare il file 
LUT. Le LUT disponibili sono presenti nella cartella specifica della 
stampante presente nel CD di installazione di ClinicalExpress. 

 

b. Se una Look Up Table non è disponibile per la stampante, attivare 
Applica funzioni di visualizzazione standard (Apply SDF), quindi: 
 Impostare l'opzione Tipo stampante (Printer Type) adattandola alla 

stampante DICOM. 
 Impostare l'opzione Tipo di trasformazione (Transformation Type) 

su SCP (la stampante applica all'immagine le funzioni di 
visualizzazione standard) o SCU (ClinicalExpress applica 
all'immagine le funzioni di visualizzazione standard). Affinché il 
Tipo di trasformazione (Transformation Type) sia valido, la 
Stampante DICOM deve supportare la Classe SOP Presentation LUT 
(consultare il manuale della stampante per maggiori dettagli); questo 
verrà negoziato dal software durante la fase di associazione. 

 Se è attivata la funzione Applica all'immagine funzioni di 
visualizzazione standard anche se non supportate dalla 
stampante (Apply SDF on image even if not supported by printer) e 
la stampante non supporta la Classe SOP Presentation (controllare il 
manuale della stampante), ClinicalExpress genera i valori delle 
funzioni di visualizzazione standard (in base ai campi Illuminazione 
(Illumination) e Luce ambientale (Ambient Light)) e applica una 
LUT all'immagine prima di inviarla alla stampante. 
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 Inserire i valori Illuminazione (Illumination) (luminanza generata 
dall'illuminazione) e Luce ambientale (Ambient Light) (luminanza 
generata dalla luce ambientale) da utilizzare nel calcolo delle 
funzioni di visualizzazione standard. I valori DICOM predefiniti 
sono: 

 Supporto trasmissivo 
(pellicola) 

Supporto riflettente 
(carta) 

Illuminazione 2000 cd/m2 150 cd/m2 

Luce ambientale 10 cd/m2 0 cd/m2 

 
c. Nella sezione Impostazioni (Settings): 
 Impostare l'opzione Ingrandimento (Magnification) come segue. Le 

opzioni disponibili sono: 
 Replica (Replicate) (ogni pixel della stampante rappresenta un 

pixel dell'immagine). 
 Nessuno (None) (adatta l'immagine alla dimensione media della 

stampante senza ricampionatura). 
 Bilineare (Bilinear) (adatta l'immagine alla dimensione media 

della stampante utilizzando una ricampionatura bilineare). 
 Cubico (Cubic) (adatta l'immagine alla dimensione media della 

stampante utilizzando una ricampionatura cubica). 
 Impostare l'opzione Orientamento pellicola (Film Orientation) su 

Verticale (Portrait) (lato lungo verticale) o Orizzontale (Landscape) 
(lato lungo orizzontale). 

 Selezionare il supporto della destinazione: Pellicola blu (Blue Film), 
Pellicola trasparente (Clear Film) o Carta (Paper). 

 Impostare la Dimensione pellicola (Film Size) della destinazione in 
pollici. 

 Impostare Densità minima del digitalizzatore (DMin) (opacità 
minima della pellicola) e Densità massima del digitalizzatore 
(DMax) (opacità massima della pellicola). 

 Attivare l'opzione Dimensioni reali (True Size) per stampare 
rispettando esattamente il formato della pellicola originale. Se questa 
opzione non è attivata, il formato dell'immagine verrà modificato e 
adattato all'area stampabile. 

 L'opzione Area stampabile (Printable Area) specifica l'area 
stampabile che verrà utilizzata per tagliare l'immagine se le 
dimensioni richieste dell'output sono maggiori dell'area stampabile 
della stampante. 
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Maggiori informazioni sull'Area stampabile 

Il duplicato di una pellicola presenta di solito un'area stampabile più piccola della pellicola originale 
avente complessivamente le stesse dimensioni.  

 Quando si stampa un'immagine su un supporto avente le stesse dimensioni della pellicola originale, 
è prevedibile che l'immagine venga ristretta o tagliata (a seconda delle impostazioni riportate nella 
sezione Configurazione (Configuration) della destinazione STAMPANTE DICOM (DICOM 
PRINTER) e delle opzioni disponibili fornite dal server e dalla stampante). 

 Quando si stampa un'immagine più piccola dell'area stampabile della stampante (che di solito è pari 
a 14" x 17"), l'immagine che ne risulta avrà le stesse dimensioni dell'originale. 

Esempio: Ipotizziamo che l'area stampabile sia 13,5" x 16,5" e che la risoluzione sia di 150 pixel per 
pollice. L'Area stampabile (Printable Area) sarebbe pari a 

14X17:2025,2475 

dove 14X17: è la dimensione della pellicola originale (deve includere la "X" maiuscola) 

 2025 è la larghezza stampabile in pixel (13,5 pollici x 150 pixel per pollice) 

 2475 è la lunghezza stampabile in pixel (16,5 pollici x 150 pixel per pollice) 

 
 
 

 Per il Tipo (Type) di destinazione POSTSCRIPT PRINTER: 
 

  
 

a. Se è disponibile una Look Up Table per la destinazione, attivare LUT, 
quindi fare clic sul pulsante ... (vedere freccia) per selezionare il file 
LUT. Le LUT disponibili sono presenti nella cartella specifica della 
stampante presente nel CD di installazione di ClinicalExpress. 

 
b. Fare clic su Impostazioni (Settings) per aprire la finestra Impostazioni 

di stampa (Print Setup) standard. In questa finestra è possibile 
selezionare una stampante e modificarne le proprietà. 

 
Nota: è necessario che siano installati i driver per stampante 
postscript per supportare questo tipo di destinazione. 
Consultare il manuale della stampante per informazioni sui 
driver. 
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 Per il Tipo (Type) di destinazione DICOM CD: 
 

  
 

a. Nel campo Copie (Copies), impostare il numero di copie da creare. 
 
b. Nel campo Drive (Unità), selezionare l'unità CD. 
 
 

 Per il Tipo (Type) di destinazione MODALITY WORK LIST: 
 

  
 

a. Attivare l'opzione Usa solo informazioni su paziente (Use Only 
Patient Information) per importare solo le informazioni di base sul 
paziente da una query Modality Worklist. 

 
b. Attivare l'opzione Abilita query avanzata (Enable Broad Query) se il 

sistema può accedere a più Modality Worklist e si desidera che l'utente 
sia in grado di cercare in tutte le MWL con una sola query. 

 
c. Attivare l'opzione Associa data inizio procedura a data studio 

(Scheduled Procedure Step Start Date to Study Date) per associare la 
data della procedura alla data dello studio quando si crea un nuovo 
account paziente effettuando una query sul server MWL. 

 
d. Attivare l'opzione Associa ID procedura richiesta a ID studio 

(Requested Procedure ID to Study ID) per collegare l'ID di una 
procedura richiesta all'ID di uno studio. 

 
 
 Per il Tipo (Type) di destinazione DICOM PATIENT QUERY, non vi sono 

opzioni di configurazione. 
 
 
6. Dopo avere inserito tutte le informazioni sulla destinazione, fare clic sul 

pulsante Salva  (Save). La nuova destinazione comparirà nella sezione 
Destinazioni (Targets) della finestra Amministrazione (Administration). 
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Gestione delle informazioni sulle destinazioni 
 
 
 Per visualizzare un elenco delle destinazioni esistenti: fare clic su 

Destinazioni (Targets) nella struttura ad albero Amministrazione. 
 

 
 
 
 Per visualizzare le impostazioni di una destinazione: fare clic sul nome della 

destinazione nella sottosezione Destinazioni (Targets) della struttura ad albero 
Amministrazione. 

 
 
 Per modificare le informazioni su una destinazione: 

 
a. Fare clic sul nome della destinazione nella sottosezione Destinazioni 

(Targets) nella struttura ad albero Amministrazione. 
  oppure 
 Fare clic sul nome della destinazione nell'elenco riepilogativo delle 

destinazioni. 
 
b. Fare clic sul pulsante Modifica (Edit). I campi diventeranno attivi e 

potranno essere modificati. 
 
c. Al termine, fare clic sul pulsante Salva (Save). 

 
 
 Per eliminare una destinazione: 

 
a. Fare clic sul nome della destinazione nella sottosezione Destinazioni 

(Targets) nella struttura ad albero Amministrazione. 
  oppure 
 Fare clic sul nome della destinazione nell'elenco riepilogativo delle 

destinazioni. 
 
b. Fare clic sul pulsante Elimina (Delete). 
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Verifica della comunicazione 

Dopo aver definito una destinazione, si raccomanda di testare la comunicazione 
tra ClinicalExpress e la destinazione o l'intermediario MWL (la funzione MWL 
di ClinicalExpress può essere acquistata separatamente). È ovviamente possibile 
eseguire il test in qualsiasi altro momento. 

1. Nella finestra principale di ClinicalExpress, selezionare File > Genera 
modello di test > SMPTE (File > Generate Test Pattern > SMPTE). Questa 
opzione utilizza uno studio speciale creato esclusivamente per finalità di test. 

2. Aprire l'elenco Destinazione (Target) e fare clic sulla destinazione da testare. 

3. Nella sezione Destinazione (Target), fare clic sul pulsante Verifica (Verify) 
(immediatamente al di sotto dell'elenco a discesa dei target). 

4. Attendere la risposta di ClinicalExpress. Verranno visualizzato dei due 
messaggi seguenti: 

 “Destinazione – [nome target]. Richiesta di verifica eseguita con successo” 
(“Target – [target name]. Verification request succeeded”) indica che la 
destinazione ha risposto al comando DICOM Echo inviato da 
ClinicalExpress. 

 “Destinazione – [nome target]. Richiesta di verifica non riuscita" ("Target – 
[target name]. Verification request failed" indica che la destinazione non ha 
risposto al comando Echo. Se viene visualizzato questo messaggio, 
controllare i dettagli di configurazione della destinazione in 
ClinicalExpress, quindi accertarsi che la rete funzioni correttamente. 

 
 
 

Modifica della configurazione del digitalizzatore di pellicole 

 
La configurazione del digitalizzatore appare nella sottosezione Digitalizzatore 
(Digitizer) della struttura ad albero Amministrazione (Administration). 
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Controllo della disponibilità della Modality Worklist 
 

Nota: l'opzione Modality Worklist di ClinicalExpress può essere 
acquistata separatamente. La copia di ClinicalExpress di cui si è 
in possesso deve disporre di licenza per Modality Worklist 
perché questa funzione sia disponibile. 

 
Nota: le istruzioni riportate in questa sezione sottintendono che 
l'amministratore ha seguito tutte le istruzioni per la creazione di 
una nuova destinazione Modality Worklist (vedere sopra, in 
questo capitolo, il paragrafo “Definizione delle destinazioni”). 

 
 
 Per stabilire se l'opzione Modality Worklist è installata: 
 

a. Nella finestra principale, accedere a Visualizzazione > Studi acquisiti 
(View > Acquired Studies). 

 
b. Nella finestra Informazioni sugli studi (Studies Information), controllare 

l'elenco Destinazioni (Targets): 
 Se l'elenco contiene almeno una destinazione, l'opzione Modality 

Worklist è installata ed è già stata impostata per una destinazione 
Modality Worklist. 

 Se l'elenco è vuoto, l'opzione Modality Worklist non è installata. 
 
c. Nella finestra Informazioni sugli studi (Studies Information), fare clic su 

Chiudi (Close). 
 
 
 Per verificare che la stazione di lavoro ClinicalExpress è collegata a una 

sorgente Modality Worklist: 
 

a. Nella finestra principale, aprire l'elenco Destinazione (Target), quindi fare 
clic su una destinazione di Modality Worklist. 

 

  
 
b. Fare clic su Verifica (Verify). 
 
c. Comparirà un messaggio in cui viene indicato se la connessione è attiva. 

 
 

Nota: tutte le istruzioni sull'utilizzo di Modality Worklist sono 
riportate nel capitolo “Importazione di dati dei pazienti esistenti 
utilizzando Modality Worklist” nella “Guida dell'operatore 
ClinicalExpress”. 
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Verifica e gestione del file di registro 

 
Il file di registro, un file di testo archiviato nella cartella del programma, contiene 
un archivio delle azioni eseguite da ClinicalExpress. Utilizzare il file di registro 
per verificare e analizzare le attività degli utenti e del programma per consentire 
la risoluzione dei problemi. ClinicalExpress fornisce una finestra che consente di 
visualizzare e gestire il file di registro. 
 
 

 
 
 
 Per visualizzare il file di registro: Visualizza > File di registro (View > Log 

File). 
 
 Per rimuovere i dati dal file di registro: fare clic su Pulisci file di registro 

(Clear Log). 
 
 Per leggere i nuovi dati presenti nel file di registro: fare clic sul pulsante 

Aggiorna (Refresh). 
 
 

Nota: impostare le opzioni relative al file di registro nella pagina 
di amministrazione Locale (Local) (vedere “File di registro” al 
paragrafo “Impostazione dei parametri della workstation locale”, 
più in alto nel presente capitolo). 

 
 



 Configurazione di ClinicalExpress 66 

19749-001 Rev. B ClinicalExpress 6.1 - Guida dell'amministratore 

Calibratura del digitalizzatore di pellicole 
 
Calibrare il digitalizzatore di pellicole come raccomandato sul manuale di 
utilizzo del digitalizzatore. 
 

Nota: la calibratura richiederà diversi minuti, durante i quali non 
sarà possibile utilizzare né il digitalizzatore né ClinicalExpress. 

 
 Per calibrare il digitalizzatore: 
 

a. Opzioni > Calibra scanner (Options > Calibrate Scanner). 
 
b. Confermare di voler iniziare la calibratura. 
 

  
 
c. Attendere che il digitalizzatore esegua la calibratura. 
 

  
 
d. Al termine della calibratura, fare clic su Sì (Yes). 
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Calibratura dello schermo 
 
Una buona qualità dell'immagine dipende dal buon rendimento dello schermo. 
Quando lo schermo mostra un'immagine in modo accurato, è possibile valutare 
efficacemente la qualità dell'immagine e ottimizzarla in modo appropriato. Anche 
se la pellicola è stata digitalizzata correttamente, l'immagine potrebbe apparire di 
scarsa qualità se visualizzata su uno schermo non calibrato. In questo paragrafo 
vengono mostrati due semplici metodi per calibrare uno schermo. 
 
Riferire i problemi di visualizzazione al medico incaricato dei controlli di qualità 
sullo schermo. I problemi di visualizzazione devono essere analizzati effettuando 
valutazioni più approfondite e devono essere seguiti da modifiche, assistenza, 
riparazione o sostituzione del dispositivo. 
 
Per una più accurata calibratura dello schermo, VIDAR raccomanda i prodotti 
VeriLUM, disponibili presso: 
 
 IMAGE Smiths, Inc. 
 P.O. Box 30928 
 Bethesda, MD  20824, Stati Uniti 
 
 Tel.: (240) 395-1600 
 Web: www.image-smiths.com 
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Calibratura con modello di test SMPTE 

1. Selezionare File > Genera modello di test > SMPTE (File > Generate Test 
Pattern > SMPTE) per aprire l'immagine del modello SMPTE (mostrata 
sotto). 

2. Ridurre al minimo il contrasto e la luminosità dello schermo. 

3. Aumentare la luminosità fino a quando saranno visibili soltanto le barre poste 
agli angoli. 

4. Aumentare il contrasto di circa l'80% o più, fino a quando saranno visibili il 
più chiaramente possibile i quadrati contrassegnati con 0%/5% e 95%/100% 
sull'immagine. 

 

Quadrato 0%/5% Quadrato 95%/100% 

Nota: se si sta consultando una copia elettronica del presente 
documento su uno schermo e non si riesce a vedere né il 
quadrato 0%/5% né il quadrato 95%/100% in questa pagina 
(indicati dalle frecce), è necessario calibrare lo schermo. 
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Calibratura con modello di test TG18-QG 
 
1. Selezionare File > Genera modello di test > TG18-QC (File > Generate  

Test Pattern > TG18-QC) per aprire l'immagine del modello TG18-QC 
(mostrata sotto). 

 

 
 
 
2. Verificare visivamente le seguenti caratteristiche: 
 

a. Distorsione geometrica: verificare che i bordi e le linee del modello siano 
visibili e diritti e che il modello sia centrato nell'area attiva dello schermo. 

 
b. Qualità generale dell'immagine e distorsioni: valutare l'aspetto generale del 

modello. Notare eventuali difformità o distorsioni, soprattutto nelle 
transizioni da bianco a nero e da nero a bianco. Verificare che le aree con 
variazione a rampa siano continue e non presentino deformazioni dei 
contorni. 
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c. Luminanza, riflesso e rumore: verificare che tutti i 16 riquadri di luminanza 
siano chiaramente visibili. Verificare che i riquadri 5% e 95% siano 
visibili. Valutare l'aspetto delle lettere a basso contrasto e confermare la 
visibilità delle destinazioni agli angoli di tutti i riquadri di luminanza. 

 
d. Risoluzione: valutare l'aspetto delle destinazioni Cx al centro e agli angoli 

del modello e confrontarli con il riferimento. I punteggi devono essere <5 
per i display primari e <7 per i secondari. Verificare inoltre la visibilità dei 
modelli a coppia di linee alla frequenza di Nyquist al centro e agli angoli 
del modello.* 

 
 
 
 
 
 
 
 
 

Contattare l'Assistenza tecnica VIDAR per eventuali 
domande sulla configurazione del software ClinicalExpress: 

Telefono: +1.800.471.SCAN (+1.800.471.7226) 

 +1.703.471.7070 al di fuori degli Stati Uniti. 

E-mail: medtech@vidar.com 

 
 
 

                                                      
* I punti da 2a a 2d sono stati ristampati con l'autorizzazione di “New Developments in 
Display Quality Control,” da Ehsan Samei, in Quality Assurance and Quality Control in 
the Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino, SCAR Premier 
Series, Society for Computer Applications in Radiology, Great Falls, VA, 2002, pp. 71-
82. 
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